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1 Zu diesem Handbuch 
Dieses Handbuch beschreibt die Bedienelemente und deren Funktionen, mit denen die 
TiXML-Console die Parametrierung des Tixi Alarm Modems / Tixi Data Gateways (nachfol-
gend allgemein „Tixi Gerät“ benannt) ermöglicht. 
 
In Kapitel 4.1 sind die einzelnen Fenster beschrieben. Die Optionen der Menüleiste und die 
Buttons sind in den Kapiteln 4.2 und 4.3 erklärt.  
 
Die mit der TiXML-Console installierten Beispiele finden Sie im Verzeichnis „Examples“ Ihrer 
TiXML-Installation. Eine Beschreibung dieser Beispiele finden Sie im TiXML-Tutorial Hand-
buch der Startmenü Programmgruppe. 
 
TiXML und die Struktur der damit anzulegenden Datenbanken (das Programm des Tixi  
Geräts) sind im TiXML-Reference Handbuch beschrieben, das sich ebenfalls in der Sterme-
nü Programmgruppe befindet. 

2 Übersicht 
Die TiXML-Console ist eine PC-basierte Anwendung, mit der Sie das Tixi Gerät konfigurieren 
und steuern können. Da die Konfiguration des Tixi Geräts aus verschiedenen Datenbanken 
mit diversen gegenseitigen Abhängigkeiten besteht, ist es notwendig, die Einstellungen 
Schritt für Schritt vorzunehmen - Zugangsdaten für Provider, Empfängerangaben für Alarm-
meldungen, deren Text und vieles mehr. 
 
Um diese Angaben im XML Format an das Tixi Gerät zu übermitteln, bietet die TiXML-
Console eine einfach zu bedienende Oberfläche, die verschiedene Datenbankabschnitte auf 
mehreren Registerkarten übersichtlich anordnet und zudem eine Überprüfung der XML Syn-
tax ermöglicht. Dies erlaubt die Konfiguration des Tixi Geräts auch ohne tiefere Kenntnisse 
des XML Formats. 
 
Die TiXML-Console ermöglicht die Steuerung des Tixi Geräts, indem sie die dafür benötigten 
Befehle in übersichtlichen Fenstern zum raschen Zugriff bereitstellt. Durch den eingebauten 
Editor lassen sich diese Templates (Vorlagen) bequem anderen Gegebenheiten anpassen 
und mit einem Mausklick zum Tixi Gerät senden. 
 
Dabei wird die Einhaltung der XML Syntax durch die eingebaute Syntaxprüfung erleichtert, 
sodass Zeitverlust und durch simple Tippfehler bedingte Probleme vermieden werden. 

3 Systemvoraussetzungen 
Betriebssystem:  Windows 2000, XP, 2003, Vista 

Hardware:     Pentium-Prozessor mit mindestens 300 MHz, Tixi Alarm Modem oder 
Tixi Data Gateway, eine freie RS232 Schnittstelle oder eine IP-
Verbindung. 

Sonstiges:    Zur korrekten Anzeige des XML-Code ist die Installation des Micro-
soft Internet Explorer 5.5 (oder höher) erforderlich. 
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4 Die Benutzeroberfläche der TiXML-Console 
Dieses Kapitel beschreibt die Elemente der Benutzeroberfläche des Programms und deren 
Funktionen.  

4.1 Der Hauptbildschirm 
Nach dem Start der TiXML-Console öffnen sich der Hauptbildschirm sowie ein zusätzliches 
kleineres Fenster, das Command Window. Der Hauptbildschirm selbst ist in drei Fenster 
unterteilt: 
 

 

Hauptbild-
schirm 

Command 
Window 

Source 
Window 

Logging 
Window 

Parser 
View / Pro-
ject View 

4.1.1  Das Source Window 
Das Source Window enthält den "XML-Quelltext" der Konfiguration, die ins Tixi Gerät über-
tragen wird. 
 
Text kann hier beliebig editiert werden, auch das Laden und Einfügen kompletter XML Do-
kumente aus ASCII Dateien ist möglich. In diesem Fenster erscheinen auch die per Doppel-
klick aus dem Command Window ausgewählten Kommandos, bevor sie ins Tixi Gerät über-
tragen werden. 

4.1.2 Parser View / Project View 
Sobald Daten aus dem Source Window in das Tixi Gerät gesendet werden, erhalten Sie eine 
Rückmeldung in der Parser View. Dabei kann es sich um einen Ergebniscode, Benachrichti-
gungen über versandte Nachrichten oder aus dem Tixi Gerät ausgelesene Datenbankab-
schnitte handeln. Falls fehlerhaft formatierte Daten ins Tixi Gerät gesendet werden, wird eine 
Fehlermeldung ausgegeben, die ebenfalls in der Parser View erscheint. 
 
Alle Ausgaben der Parser View sind XML formatiert, so dass Tags und eigentliche Daten 
leicht zu erkennen und zu unterscheiden sind. Mit der rechten Maustaste können Sie ein 
Kontextmenü öffnen, das die Option zur Anzeige des kompletten Quelltextes bietet. 
 
Wenn Sie eine komplette Konfiguration von der Festplatte oder aus dem Gerät selbst laden, 
wird der Parser View ein Register „Project View“ hinzugefügt. Beim Wechsel auf dieses Re-
gister erhalten Sie eine Auswahl der vorhandenen Datenbanken im Projekt. Beim Klick auf 
einen dieser Einträge, wird die gewählte Datenbank im Source Window zur weiteren Bear-
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beitung angezeigt. Ein Wechsel der Datenbank speichert die gemachten Änderungen auto-
matisch in die Projektdatei. 
 

 
 
Der Rechtsklick auf einen Eintrag der Project View ermöglicht über ein Kontextmenü das 
Löschen der derzeit markierten Datenbank. Die Datenbank wird lediglich ausgeblendet und 
kann somit später über das Menü (siehe Kapitel 4.2.6) mit den alten Daten wieder hinzuge-
fügt werden.  
 

 
 
Beachten Sie, dass ausgeblendete Datenbanken nicht mit zum Modem übertragen werden! 
 

4.1.3  Das Logging Window 
Hier werden alle Statusmeldungen, Aktionen und sämtlicher Datenverkehr der TiXML-
Console aufgezeichnet. Fehlermeldungen, Benachrichtigungen sowie gelesene und gesen-
dete Daten sind zur leichteren Unterscheidung mit verschiedenen Farben hinterlegt: 
  
Grau:  
TAM => Konsole 

Grün:  
Konsole => TAM 

Rot:  
Fehlermeldungen 

Weiss:  
Trennlinien 

 
  
Das Kopieren von Text ist in diesem Fenster nicht möglich. Einfacher können Sie auf die 
gesammelten Logging Informationen zugreifen, indem Sie die über die Menüleiste zugängli-
che Logging Option verwenden: Diese erlaubt, den Inhalt des Logging Window komplett in 
einer ASCII Datei zu speichern. In Kapitel 4.2.5 finden Sie nähere Informationen dazu. 

4.1.4 Das Command Window 
Im Command Window finden Sie die meisten Kommandos, die Sie zur Konfiguration und 
Steuerung des Tixi Geräts benötigen. Die Kommandos sind in einzelne Themenbereiche 
gegliedert.  
 
Kommandos sind durch [ ] gekennzeichnet. 
Parameter sind durch < > gekennzeichnet. 
 
Durch einen Doppelklick auf einen der Einträge können Sie das betreffende Kommando in 
seiner vollständigen XML Syntax ins Source Window kopieren. Beachten Sie dabei, dass die 
mit eckigen Klammern gekennzeichneten Kommandos den Inhalt des Source Window über-
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schreiben; im Gegensatz zu den mit spitzen Klammern gekennzeichneten Werten und Pa-
rametern. 
 
Wenn Sie die TiXML-Console im Test-Modus betreiben (siehe Kapitel 4.3.1), finden Sie im 
Source Window statt der Kommandos und Parameter die Test Templates, mit denen Sie die 
Ereignisverarbeitung des Tixi Geräts testen können. 
 
Ein Doppelklick auf einen Parameter im Command Window fügt den betreffenden XML Code 
an derjenigen Stelle im Source Window ein, an der sich der Cursor befindet. Der übrige In-
halt des Fensters wird dadurch nicht beeinflusst, so dass sie den Text im Source Window 
auch aus mehreren Einträgen des Command Window zusammenstellen können. Eine Über-
sicht über die Syntax und den Zweck der Befehle im Command Window finden Sie im 
TiXML-Reference Handbuch. 
 
Um das Command Window anzuzeigen oder zu verstecken, benutzen Sie die Option  
[View] > [Command Window] in der Menüleiste 

4.1.5 Das Menü "Test Templates" 
Um Konfiguration und Tests zu erleichtern, können Sie - sofern sich die TiXML-Console im 
Test Mode befindet - im Command Window auch eigene Templates anlegen und bearbeiten. 
Aktivieren Sie dazu den Test Mode. Im Command Window wird nun die Option "Test 
Templates" angezeigt. Hier haben Sie diese Möglichkeiten: 
 
New  Hier können Sie neue Templates anlegen. Es stehen vier Varianten zur Auswahl: 
 

Empty erzeugt nur leeren Eintrag in der Liste der Templates, dem Sie beliebigen 
Text zuweisen können. 

Read Logfile erzeugt einen neuen Eintrag, der den Befehl zum Abfragen von Logda-
ten vorgibt. Sie müssen lediglich den Logfile Namen und den Bereich anpassen. 

Event (with Parameter) erzeugt einen neuen Eintrag, der bereits die Einträge für die 
Übermittlung eines Events sowie für die Übergabe von Parametern enthält, die Sie 
noch vervollständigen müssen. 

Event (no Parameter) erzeugt eine Vorlage für die Übermittlung eines Ereignisses, 
jedoch ohne Parameter. 

Set Variable Bus erzeugt einen Eintrag zum setzen einer Variable. Sie müssen le-
diglich den Pfad und Wert anpassen. 

Clone Markieren Sie ein Template und benutzen Sie dann diese Option, um eine genaue 
Kopie des markierten Template unter einem neuen Namen zu erzeugen. Nachdem 
Sie den Text im Source Window geändert haben, können Sie das neue Template 
mit dem "Save" Button im Command Window speichern. 

 
Rename 

Mit dieser Option können Sie das gerade markierte Template umbenennen. Beach-
ten Sie dabei, dass es dazu nicht leer sein darf. 

 
Delete Wenn Sie diese Option auswählen, wird das gerade markierte Template gelöscht. 
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4.2 Die Menüleiste 
 Hier sind die Befehle beschrieben, die Sie unter den einzelnen Menüpunkten finden. 
 

 

4.2.1  Das Menü [Project] 
New: 

Wählen Sie diesen Menüpunkt, wenn Sie ein komplett leeres Projekt als Vorlage er-
zeugen wollen. Es empfiehlt sich aber eher den nächsten Menüpunkt zu verwenden, 
da beim Auslesen aus dem Modem bereits das Grundgerüst der Daten ausgelesen 
wird. 
Die Schreibarbeit wird dadurch erheblich gemindert. 

 
Open from Tixi device:  

Hiermit können Sie das im Tixi Gerät gespeicherte Projekt auslesen und im Source 
Window der TiXML-Console anzeigen lassen. Dabei werden die verschiedenen Ab-
schnitte der Datenbank auf verschiedenen Registerkarten dargestellt, um einen einfa-
chen Überblick zu ermöglichen. Die Daten können Sie als Projektdatei auf der Festplat-
te des PC abspeichern und später jederzeit wieder laden. 
Ein TICO-Projekt besteht immer aus einer Datei mit der Endung “.tico“ (in älteren Ver-
sionen „.cnf“) und einem gleichnamigen Verzeichnis, welches die verschiedenen Re-
gister in separaten TXT-Dateien enthält. 

 
Open from File:  

Auch dies lädt ein komplettes Projekt zur Ansicht in das Source Window der TiXML-
Console - jedoch nicht aus dem Gerät selbst, sondern von der Festplatte. Dabei kann 
es sich z.B. um die mitgelieferten Beispiele handeln, die Sie editieren und ins Tixi Ge-
rät übertragen können. „.tico“ Projektdateien lassen sich auch per Doppelklick öffnen. 

 
Close:  

Dies schließt das aktuell geöffnete Projekt. Wenn Sie ein neues Projekt in die TiXML-
Console laden wollen, müssen Sie ggf. das momentan geöffnete zuerst schließen. 
Die Option steht im „Test-Mode“ (siehe 4.3.1) nicht zur Verfügung. 

 
Save:  

Das momentan geladene Projekt kann hier gespeichert und später mit dem Befehl "O-
pen from File" (siehe oben) jederzeit wieder in die Konsole eingelesen und weiterver-
arbeitet werden. Beachten Sie, dass das unter demselben Dateinamen auf der Fest-
platte befindliche Projekt dabei überschrieben wird. Um es unter einem anderen Na-
men zu speichern, benutzen Sie diesen nächsten Menüeintrag: 

 
Save as:  

Hier können Sie das Projekt ebenfalls speichern, ihm jedoch dabei einen neuen Datei-
namen geben und so das Überschreiben der bisherigen Projektdatei auf der Festplatte 
vermeiden. 

 
Send:  

Dieser Befehl sendet nur die Abschnitte des Projekts ins Tixi Gerät, die geändert, und 
seitdem noch nicht gesendet wurden. Wenn Sie eine komplette Konfiguration geladen 
haben und diese komplett - also die Inhalte aller Registerkarten - ins TixiGerät übertra-
gen wollen, müssen Sie nicht jede Registerkarte einzeln senden; benutzen Sie dazu 
einfach diesen folgenden Befehl: 
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Send all:  
Dies überträgt das momentan in der Konsole geladene Projekt komplett ins Tixi Gerät. 
Das heißt, die Inhalte aller Registerkarten werden übertragen, und nicht nur die geän-
derten Daten.  
Ein Fortschrittsbalken unterhalb des rechten Fensters gibt Auskunft über den Übertra-
gungsstatus. 

 
Import TILA project:  
  Konvertiert ein mit TILA2 erstelltes Projekt (Endung *.TiXML) in ein TICO Projekt. 
 
Liste: 

Sobald ein Projekt gespeichert oder geladen wurde, wird es der Liste der letzten 4 ge-
öffneten Dateien hinzugefügt. Hier können Sie schnell auf diese Projekte zugreifen. 
 

Exit:  Ein Klick auf diese Option beendet die TiXML-Console.  
 

4.2.2 Das Menü [File] 
Open:  Benutzen Sie diese Option, um eine Textdatei von der Festplatte zu laden. Deren 

Inhalt wird im Source Window dargestellt, von wo Sie es ins Tixi Gerät übertragen 
können. Dies ist dann sinnvoll, wenn Sie einzelne Konfigurationsdaten in separaten 
Textdateien gespeichert haben und diese ins Tixi Gerät übertragen werden sollen, 
um z.B. ein komplettes Projekt neu zu erstellen. 

 
Save:  Dies speichert den Im Source Window angegebenen Text in einer Datei. Nutzen Sie 

diese Möglichkeit, um z.B. schnell eine Sicherheitskopie der aus dem Tixi Gerät aus-
gelesenen Daten anzufertigen, bevor Sie diese Daten ändern und wieder ins Tixi Ge-
rät senden. 

 

4.2.3  Das Menü [Port] 
Im Menü [Port] können Sie bestimmen, an welcher der Schnittstellen die TiXML-Console 
das Tixi Alarm Modem zu finden versucht. Eine Automatik findet den richtigen RS232 An-
schluss, wenn Sie ihn nicht kennen. 
Eine Auswahl der Schnittstelle ist nur dann möglich, wenn die TICO zuvor „offline“ geschaltet 
wurde (siehe Kapitel 4.3.6). 
 
COM1...COM16:  

Wenn Sie die serielle Schnittstelle kennen, an der das Tixi Gerät angeschlossen ist, 
wählen Sie sie hier aus. Die TiXML-Console wird versuchen, das Tixi  

  Gerät am angegebenen COM-Port anzusprechen. 
 
TCP/IP:  

Verwenden Sie diese Option, um sich mit einem Tixi Gerät via TCP/IP zu verbinden. 
Dies kann über ein lokales Netzwerk (Tixi Data Gateway) oder das Internet erfolgen 
(Der PC und das Tixi Gerät müssen „online“ sein). Die TCP/IP-Einstellungen werden 
im Kapitel 4.2.7 erklärt. 

 
Auto:  

Wenn Sie sich über den COM-Port nicht sicher sind, benutzen Sie diese Option. Die 
TiXML-Console wird dann alle verfügbaren Schnittstellen nach einem Tixi Gerät absu-
chen und diejenige verwenden, an der eins angeschlossen ist. 

 8 



TiXML-Console TICO 

4.2.4 Das Menü [View] 
Hier können Sie die Darstellung der TiXML-Console beeinflussen. Aktivieren Sie die Optio-
nen [Command Window] bzw. [Logging Window], um die Darstellung der entspre-
chenden Fenster ein- oder auszuschalten. 

4.2.5 Das Menü [Logging] 
Logging:  

Mit diesem Menüpunkt können Sie die Logging Funktion ein- und wieder ausschalten. 
Der eingeschaltete Zustand ist durch ein Häkchen neben dem Menüeintrag gekenn-
zeichnet. 
 

File Name:  
  Geben Sie hier den Dateinamen für das Logfile an.  

4.2.6 Das Menü [Tools] 
Switch Mode: 

Hier können Sie den Betriebsmodus zwischen TiXML-Mode und Modem-Mode hin und 
her schalten. Ist der TiXML-Mode aktiv, so lässt sich das Tixi Gerät mittels der TiXML-
Console konfigurieren und steuern; es reagiert dann auf TiXML Befehle und verarbeitet 
auf diese Weise übergebene Ereignisse.  
 
Im Modem-Mode lässt sich das Alarm Modem als normales Modem verwenden. Der 
Modem-Mode wird durch die leuchtende Modem-Mode LED am Gerät signalisiert.  
 
Im ModemMode reagiert das Alarm Modem nicht auf TiXML-Befehle! 

 
Wait for Client (TCP/IP): 

Wenn Sie Probleme bei der Bedienung der TICO haben, kann dem Tixi-Support über 
diesen Menüpunkt der Fernzugriff auf die Software übers Internet gestattet werden, um 
Ihnen bei der Bedienung behilflich zu sein.  

 
Remote connect / Disconnect: 

Sie können mit der TICO ein Tixi Alarm Modem aus der Ferne parametrieren. Mit Hilfe 
dieses Menüpunktes wird mit einem herkömmlichen Modem eine Verbindung zu dem 
entfernten Alarm Modem hergestellt (siehe Kapitel 5). 
Während einer aktiven Verbindung wird der Menüpunkt in „Disconnect“ umbenannt, 
und kann dann zum Trennen der Verbindung verwendet werden. 
 

Set Process RUN/STOP: 
Über diesen Menüpunkt können Sie die Prozessabarbeitung im Modem starten (RUN) 
und anhalten (STOP). Besonders beim Austausch von großen Projekten ist das anhal-
ten der Prozessabarbeitung notwendig (wie bei einer SPS) und wird ohnehin beim 
kompletten Projektupload von TICO automatisch ausgeführt. Wenn Sie einzelne Da-
tenbanken ändern, können Sie diese Menüpunkte zum manuellen Ändern des Geräte-
status verwenden. 

 
Add missing registers: 

Wenn Sie aus einem TiXML-Projekt einzelne Datenbankregister gelöscht haben, kön-
nen Sie diese über diese Schaltfläche wieder hinzufügen. Tixi.Com bringt regelmäßig 
neue Funktionen für das Tixi Gerät heraus, die zum Teil auf neuen Registern pro-
grammiert werden. Nach einem TICO Update können Sie über diesen Menüpunkt die 
neuen Register zu Ihren alten Projekten hinzufügen. 
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Nach der Auswahl dieses Menüpunktes erscheint eine Auswahl aller noch nicht im Pro-
jekt vorhandener Register: 
 

 
 
  Die Schaltfläche „Add selected register“ fügt das markierte Register dem Projekt hinzu. 
  Über „Cancel“ können Sie die Auswahl abbrechen. 
 

4.2.7 Das Menü [Settings] 
 
Baudrate: 

Über diesen Menüpunkt können Sie die Baudrate wählen, mit der die TICO mit dem 
Modem Kommuniziert. Bei der 100/400er Reihe muss 115200bps eingestellt sein! 

 
TCP/IP: 

Dieser Menüpunkt öffnet die TCP/IP Konfiguration in welcher Sie die Adresse des Tixi 
Geräts und den Winsock-Port für TiXML-Kommunikation (Standard TCP 8300) ange-
ben können:  
 

     
 
Font: 

Mit dieser Option legen Sie die Schriftart im Editorfenster fest. Wir empfehlen die Ver-
wendung einer Festbreitenschriftart wie z.B. „Courier new“, da dies die Lesbarkeit der 
TiXML-Syntax verbessert. 

 
Properties 

Die Properties dienen der Einstellung des COM-Port Timings sowie der Template Ver-
sion. 
 
Das COM-Port Delay legt fest, wie viele Millisekunden nach der Öffnung des COM-
Ports gewartet werden. Dies ist nur bei Notebooks notwendig, die COM-Ports in einen 
Energiesparmodus setzen. 
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Die Template Version bestimmt die Projektstruktur im Tixi Gerät. Da Tixi den Funkti-
onsumfang der Geräte regelmäßig erweitert, kommen mit einer neuen Firmware auch 
neue Befehle und Register hinzu, bzw. alte Register werden zusammengefügt oder 
entfernt. 
Um Inkompatibilitäten zu verhindern, muss die hier eingestellte Firmwareversion zur 
der auf dem Tixi Gerät passen. 
Um mit TILA erstellte Projekte verarbeiten zu können, muss die Einstellung immer auf 
„FW = 2.0 (TILA)“ stehen. 
 

 
 

4.2.8 Das Menü [Help] 
 
About TICO TiXML Console: 

Hier werden die Versionsinformationen der TiXML-Console angezeigt. 
 
Help: 
  Öffnet dieses Handbuch. 
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4.3 Die Buttonleiste 

  

Die Buttonleiste stellt Ihnen die wichtigsten "Werkzeuge" bereit, die 
Sie für häufig vorkommende Operationen brauchen. Außerdem 
finden Sie hier eine Anzeige, die den Datenverkehr zwischen 
TiXML-Console und dem Tixi Gerät signalisiert. Falls die Übertra-
gung aus irgendeinem Grunde "hängt", können Sie sie von hier aus 
jederzeit abbrechen. 
 

4.3.1 [Test] 
Hiermit können Sie die TiXML-Console in den Test-Mode schalten, 
sofern ein Projekt geladen wurde. In dieser Betriebsart lässt es sich 
nicht konfigurieren, aber Ereignisse können ausgelöst werden. Das 
Tixi Gerät reagiert darauf im Test-Mode genauso wie im Normalbe-
trieb, so dass Sie hier Ihre Konfiguration auf Herz und Nieren prü-
fen können. 
 

 
 
Im Test-Mode können Sie die Konfiguration nicht bearbeiten; dazu müssen Sie diesen Mo-
dus wieder abschalten. Solange er aktiv ist, können Sie statt der vorgefertigten Kommandos 
aus dem Command Window nun die für Ihr Projekt definierten Ereignisse abrufen und ins 
Tixi Gerät senden. 
 
Der aktive Test-Mode wird durch die gelbe Färbung des Test Button signalisiert. 
 
Das Source Window merkt sich die zuletzt eingegebenen Daten, so dass Sie zwischendurch 
den Test-Mode verlassen können. 

4.3.2 [Check] 
Benutzen Sie diesen Button, um die XML Syntax des Textes im Source Window zu prüfen. 
Dazu wird der Text als XML formatiertes Dokument in der Parser View ausgegeben. Da dies 
nur bei einer vollständigen Syntax möglich ist, können formale und Tippfehler sofort erkannt 
werden. Wenn etwas nicht korrekt ist, wird in einer Fehlermeldung auf Ort und Art des Feh-
lers verwiesen. Die in der Fehlermeldung ggf. angezeigte Zeilennummer bezieht sich auf den 
im Source Window angezeigten Text. 
 
Beachten Sie, dass der [Check] Button ausschließlich die XML Sprachsyntax prüft. Die 
korrekte Schreibung der TiXML spezifischen Kommandos bleibt davon unberührt. 
 
Der Button ist im Projekt-Modus nur verfügbar, wenn der „Parser View“ Register im rechten 
Fenster ausgewählt wurde. 

4.3.3 [Send] 
Dieser Button sendet alle geänderten Abschnitte eines Projekts in das Tixi Gerät. Wenn kei-
ne Datenbank geöffnet ist, wird der aktuelle Inhalt des Source Window übertragen. Der 
[Send] Button sollte aus naheliegenden Gründen nur dann betätigt werden, wenn tatsäch-
lich ein Tixi Gerät angeschlossen und die TiXML-Console damit verbunden ist. 
 
Ein Fortschrittsbalken unterhalb des rechten Fensters gibt Auskunft über den Übertragungs-
status. 
 
Um die komplette Konfiguration - unabhängig von Änderungen - ins Tixi Gerät zu senden, 
benutzen Sie den Menüeintrag [Project] > [Send All] (siehe Kapitel 4.2.1). 
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4.3.4 [Break] 
Wenn die Übertragung von Daten zwischen der TiXML-Console und dem Tixi Gerät aus ir-
gendeinem Grunde "hängt" oder sonst wie nicht zu einem ordentlichen Abschluss kommt, 
können Sie sie hier jederzeit abbrechen. Falls sich in der TiXML-Console oder im Tixi Gerät 
nach dem Abbruch eine unvollständige Konfiguration befindet, kann diese durch erneutes 
Laden der Daten vervollständigt werden. Durch den Abbruch der Übertragung gehen keine 
Daten verloren und es kann weder die Hard- noch die Firmware des Tixi Geräts beschädigt 
werden. 

4.3.5 [Save] 
Dieser Button bewirkt dasselbe wie der Menüeintrag [Project] > [Save] (siehe Kapitel 
4.2.1) - das heißt, die komplette im Source Window dargestellte Konfiguration wird auf der 
Festplatte gespeichert, von wo aus sie jederzeit wieder in die TiXML-Console geladen wer-
den kann. 
 
Der [Save] Button speichert stets in die in der Titelleiste der TiXML-Console angezeigte 
Datei. 
 

4.3.6 [Offline] 
Falls Sie nur eine Projektdatei editieren wollen oder kein Tixi Gerät angeschlossen ist, wäh-
len Sie diesen Modus. Die TiXML-Console wird dann nicht versuchen, eine Verbindung zum 
Tixi Gerät herzustellen und blockiert nicht die Schnittstelle. Die Konfigurationsdaten eines 
Projekts können bearbeitet und auf der Festplatte gespeichert werden. 
 
Das Schalten in den Offline-Modus ist auch beim Wechsel des COM-Ports notwendig, oder 
um nach einem „TransMode“ Befehl mit einer anderen Anwendung auf die am Tixi Gerät 
angeschlossene Steuerung zuzugreifen. 
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5 Fernzugriff auf ein Alarm Modem 
Die TICO ermöglicht auch den Fernzugriff auf ein Alarm Modem mit Hilfe eines herkömmli-
chen Modems. Über den Menüpunkt [Tools] -> [Remote Connect] erhält man Zugriff 
auf das Einwahlfenster: 
 

   
 
Phone number: 

Tragen Sie hier die Rufnummer des anzurufenden Alarm Modems inkl. Einer ggf. not-
wendiger Amtsholung ein. Die zehn zuletzt gewählten Rufnummern können in der 
Drop-Down Liste ausgewählt werden. 

 
Init command (optional): 

Hier können spezielle AT-Befehle zur Initialisierung des Einwahlmodems angegeben 
werden. 

 
Dial options: 

Die Modemparameter wie Tonwahl (ATDT) und Pulswahl (ATDP) oder das Warten auf 
den Wählton (ATX4) können bequem über diese Auswahl eingestellt werden. 

Login: 
Tragen Sie die Zugangsdaten zum Alarm Modem ein, falls dieses zugriffgeschützt ist. 

Sollen die Zugangsdaten zusammen mit einer der letzten 10 Rufnummern gespeichert 
werden, aktivieren Sie die Option „Keep Password“. 

Das „Delay after CONNECT(s)“ ist bei GSM-Anbietern nötig, die die CONNECT-
Meldung zu früh ausgeben. Je nach Verzögerung sind Werte zwischen 1 und 5s sinn-
voll. 

 
Die Option „Protocol in „RemoteConnect.txt“ (yes/no)“ protokolliert die Anwahlversuche 
in einer txt-Datei, und erleichert ggf. die Fehlersuche. 
 
Über den Button [Connect] erfolgt der Anwahlversuch. Wenn die Verbindung erfolgreich auf-
gebaut wurde, erscheint ein entsprechender Hinweis. Ebenso im Fehlerfall. Über den Button 
[Cancel] kann der Anwahlversuch abgebrochen werden. 
 
Nach dem Fernparametrieren kann die Verbindung über den Menüpunkt [Tools] -> 
[Disconnect] wieder getrennt werden. 
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